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หลักการและเหตุผล 

New media หรือ สื่อใหม่ เป็นช่องทางการสื่อสารรูปแบบใหม่ที่เริม่เข้ามามีบทบาทมากขึ้นใน
ปัจจุบัน ไม่ว่าจะเป็นการสื่อสารโดยใช้อุปกรณ์สื่อสาร หรือ Mobile Media เช่น โทรศัพท์มือถือหรอื 
Tablet รวมถงึเครือข่ายสังคมออนไลน์ (Social Media) เช่น FaceBook, Twitter, Youtube เป็นต้น 
สื่อใหม่เหล่านี้ได้กลายเป็น “สื่อมวลชนยุคใหม่” ซึ่งมีผูใ้ช้เพิ่มมากขึ้น ทําให้บริษัท หน่วยงานสื่อ
ประชาสัมพันธ์ทั้งในและนอกประเทศเริ่มทําการตลาดหรือการประชาสัมพันธ์ผ่านช่องทาง New 
Media เพื่อให้เข้าถึงเฉพาะเจาะตัวบุคคลมากขึ้น นอกจากนี้การประชาสัมพันธ์ผ่านสือ่ใหม่นี้ ยังเป็น
การหลอมรวมสื่อมัลติมีเดียทัง้หลาย ทําให้ขอ้มูลมีความน่าสนใจ  

จะเห็นไว้ว่าผู้ใช้อุปกรณ์สื่อสารจึงน่าจะเป็นกลุ่มผู้รับสื่อที่เป็นกลุ่มเป้าหมายอีกกลุ่มหนึ่งที่เรา
จะสามารถเผยแพร่ข้อมูลข่าวสารได้เพิ่มขึ้น ดังนั้น จึงมีความจําเป็นอย่างยิ่งที่ต้องมีการศึกษาและให้
องค์ความรู้ด้านบริหารจัดการข้อมูลข่าวสารของกรมประชาสัมพันธ์ผ่านสื่อใหม ่(New Media) แก่
บุคลากรกรมประชาสัมพันธ์ เพื่อให้มีการพัฒนาประสิทธิภาพและคุณภาพด้านการประชาสัมพันธ์และ
สื่อสารมวลชนให้ครอบคลมุ และขยายทันสงัคมออนไลน์ให้สมกับความเป็นผู้นําด้านการประชาสัมพันธ์ 
 
วัตถุประสงค ์

1. เผยแพร่องค์ความรู้ด้านเทคโนโลยีสารสนเทศในการเพิ่มช่องทางการเผยแพร่ข้อมูลข่าวสารการ
ประชาสัมพันธ์ผ่านสื่อใหม ่(New Media) เพื่อพัฒนาประสิทธิภาพและคุณภาพด้านการ
ประชาสัมพันธ์และสื่อสารมวลชน 

2. เพื่อให้ผู้ปฏิบัติงานในหน่วยงานได้รับความรู้ ความเข้าใจในขั้นตอนการทํางาน และปฏิบัติงาน
ไปเป็นในมาตรฐานเดียวกัน 

 
ขอบเขต 

คู่มือการปฏิบัติงานนี้ มีเนื้อหาของการบริหารจัดการข้อมูลข่าวสารของกรมประชาสัมพันธ์ผ่านสื่อ
ใหม่ (New Media)  โดยสื่อใหม่ที่ใช้ 2 ประเภท คือ PODcast และ Digital Content  แต่ด้วยแต่ละประเภท
นั้น สามารถสร้างได้ในหลายๆแบบ ในการศึกษาครั้งนี้จึงได้ศึกษาประเภทละ 1 ชนิด และได้แนบเอกสารคู่มือ
มาพร้อมนี้ คือ คู่มือการสร้างวิทยุออนไลน์บนแอนดรอยด์ (Radio Online on Android) และ คู่มือการใช้งาน  
Plug-in บน FaceBook 
 
 
 
 
 
คําจํากัดความ 

New Media หมายถึง สื่ออิเล็กทรอนิกส์รปูแบบใหม่ทีส่ามารถรับ-ส่งข้อมูลข่าวสาร ซึง่เป็นสื่อ
ประสม (Multimedia) ในรูปแบบดิจิตอลผ่านโครงข่ายบรอดแบนด์ทั้งแบบมีสายและไร้สาย แบ่ง
ออกเป็น 2 ประเภท คือ Podcast และ Digital Content 
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1. Podcast หรือ Podcasting POD ซึ่งเป็นคําย่อมาจาก Personal On-Demand คือ การ
แจกจ่ายไฟล์เสียงหรือไฟล์วีดีโอผ่านอินเทอร์เน็ต โดยให้ผู้ใช้เลือก Subscribe ไฟล์ Feed 
(เอกสารในรูปแบบ XML) ผ่านโปรแกรมอ่านเฉพาะที่เรียกว่า Aggregator เช่น iTunes, iPod 
เป็นต้น 

2. Digital Content คือ สารสนเทศที่มีรูปแบบดิจิตอล โดยอาศัยการสื่อ หรือการแสดงเนื้อหา
ผ่านทางอุปกรณ์ดิจิตอลต่างๆ เช่น คอมพิวเตอร์ อินเทอร์เน็ต สื่อสังคมออนไลน์ (Social 
Media) และอปุกรณ์สื่อสาร (Mobile media) ต่างๆ 

 

 
ภาพแสดงการทํางานของ Podcast 

 
 
 
 
 
 
 
กระบวนการและแนวทางการปฏิบัติงาน 
 สําหรับการขั้นตอนและแนวทางในการสร้างสื่อประชาสัมพันธ์ในรูปแบบ New Media นั้น มี
ภาพรวมๆ ดังนี้ 
 
ที่ กระบวนการ รายละเอียด 
1.  คัดเลือกข้อมูลข่าวสารที่ต้องการ

ประชาสัมพันธ์ 
 

- คัดเลือกข้อมลูข่าวสารจากศูนย์ข้อมูลข่าวกลาง
ของ กรมประชาสัมพันธ์ หรือจากสื่อสิ่งพิมพ์ เช่น 
วารสารกรมประชาสัมพันธ์ เป็นต้น 
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2.  วิเคราะห์เนื้อหาของข้อมูลข่าวสาร - วิเคราะห์เนื้อหาของข้อมูลข่าวสาร เพื่อกําหนด
กลุ่มเป้าหมาย และช่องทางการประชาสัมพันธ์  

3. คัดเลือกประเภทของสื่อใหม ่(New Media) 
ที่เหมาะสมกับกลุ่มเป้าหมาย 

- หากเนื้อหาเหมาะสําหรับสือ่ใหม่ จากการ
วิเคราะห์เนื้อหาของข้อมูลข่าวสาร เลือกว่าจะใช้สื่อ
แบบ Podcast หรือ Digital Content หรือทั้ง 2 
ทาง 

4. วิเคราะห์ ออกแบบ และพัฒนาสื่อใหม ่ - วิเคราะห์ความต้องการของระบบสารสนเทศที่ต้อง
ใช้ในการพัฒนา 

  - แปลงรูปแบบของข้อมูลข่าวสารให้อยู่ในรปูแบบที่
เหมาะสมกับช่องทางสื่อใหม่ 
- ออกแบบระบบ 
- พัฒนาระบบ  

5. ทดสอบระบบ ก่อนใช้งานจริง - ทดสอบระบบ และแก้ไขปรับปรุง เพื่อให้ง่ายต่อ
การใช้ 

6. เผยแพร่ข้อมูลข่าวสาร และประชาสัมพันธ์ให้
เข้าถึงกลุ่มเป้าหมาย 

ดําเนินการประชาสัมพันธ์ เช่น 
- สร้างกิจกรรมส่งเสริมต่างๆ 
- สร้างเครือข่ายการให้บริการสารสนเทศทางสื่อ
เครือข่ายสังคมออนไลน์ และมีปฏิสัมพันธ์กับ
กลุ่มเป้าหมาย โดยใช้ Application ที่มีอยู่แล้วใน 
Facebook, Twitter, Ficker, Youtube เป็นต้น 

7. ตรวจสอบ และประเมินผล - ตรวจสอบการทํางานของระบบ และการตอบรับ
จากกลุ่มเป้าหมาย เพื่อประเมินประสิทธิภาพในการ
ประชาสัมพันธ์ต่อไป เช่น การใช้รายงานสถิติและ
เครื่องมือในการวิเคราะห์อัตราการเข้าชมเว็บไซต์ 

 
 และในกิจกรรมการจัดการความรู้ครั้งนี้ ศสช. ได้ศึกษาถึงเรื่อง New Media ด้วยการสร้าง
แอพพลิเคชั่นบนโปรแกรมแอนดรอยด์ ซึ่งมีขั้นตอนการพัฒนาตามเอกสารแนบในภาคผนวก 

1. คู่มือการสร้างวิทยุออนไลน์บนแอนดรอยด์ (Radio Online on Android) 
2. คู่มือการใช้ Plug-In ใน Facebook 

 ซึ่งคู่มือทั้ง 2 ขา้งต้นจะเป็นวิธีการสร้างสื่อใหม่ และการสนับสนุนการประชาสัมพันธ์ผ่านสื่อ
ใหม ่
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แผนภาพแสดงขั้นตอน 
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แนวทางการสง่เสริมการประชาสัมพนัธส์ูส่ังคมออนไลน ์(Social Media) 
 จากที่กล่าวไว้ในหัวข้อคําจํากัดความแล้ว ว่าสังคมออนไลนจ์ัดได้ว่าเป็น New media อย่าง
หนึ่ง ซึ่งปัจจุบันเป็นที่นิยมใช้กันมากขึ้น ซึ่งการจะทําให้การประชาสัมพันธ์ข้อมูลข่าวสารได้ผลดีนั้น ซึ่ง
จะขอเสนอแนวทาง ที่ใช้เว็บประเภท Social Network มาช่วยประชาสัมพันธ์ ดังนี้ (มีคู่มือการใช้งาน 
Facebook ในภาคผนวก) 

1. ส่งข้อมูลขา่วสารสู่ Facebook ของเพื่อนหรือผู้ตอบรับเป็นสมาชิกโดยตรง ในกรณีทีม่ีขา่วสาร
ที่น่าสนใจ และควรพิจารณาว่าผู้รับข้อมูลเป็นกลุ่มเป้าหมายชองข้อมูลนั้นๆ  

2. สร้างกิจกรรมบน Facebook หรือ Fanpage  การจัดกิจกรรมสร้างความสัมพันธ์ต่างๆ 
สามารถทําได้ง่ายเนื่องจากเราสามารถให้รายละเอียดต่างๆ  ของกิจกรรมได้อย่าง
ครบถ้วน  ระบุรายละเอียดลงใน profile ของเรา และส่งถึงเพื่อนๆ และผูต้อบรับเป็นสมาชิก 
หรือแฟนๆ Facebook ของเรา (ดูวิธีการสร้าง Fanpage ในภาคผนวก) 

3. ส่งเนื้อหาจากเว็บไซต์หลักของหน่วยงานเข้า Fan page อาจจะใช้วิธีส่งผ่าน RSS เพื่อ
ประหยัดเวลา 

4. ใช้ทวิตเตอร์ (Twitter) ในการประชาสัมพันธ์และชักชวนให้คนติดตามข้อมูล 
5. ประชาสัมพันธ์โดยใช้การอัปโหลดไฟล์วิดีโอด้วย YouTube เพราะสามารถสร้างวิดีโอสั้น ๆ ใน

การประชาสัมพันธ์ โดยบอกผู้รับชมว่าจะรับทราบข้อมูลเพิ่มเติมได้ที่ใด 
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ประโยชน์ของการใชส้ื่อใหม ่New Media 
1. ประโยชน์ของการประชาสัมพันธ์ผ่าน PodCast 

1.1. จูงใจผู้รับข่าวสารด้วยรูปแบบข้อมูลที่ดึงดูดใจ เพราะสามารถเผยแพร่ได้แบบมัลติมีเดีย ไม่ว่า
จะเป็นภาพ เสียง หรือภาพเคลื่อนไหว 

1.2. ทําให้ผู้รับข่าวสารสามารถตดิตามข้อมูลข่าวสารได้ทุกที่ ทุกเวลา และทกุสถานที่เมื่อต้องการ 
เพราะ Podcast นั้นสามารถเล่นได้ทั้งบนอุปกรณ์สื่อสาร (Mobile Media) และบนเครือ่ง
คอมพิวเตอร์ส่วนบุคคล 

1.3. ประชาสัมพันธ์ได้ตรงกลุ่มเป้าหมาย  เนื่องจากมีการรวบรวมเนื้อหาไว้เป็นหมวดหมู่ทําให้ผู้รับ
ข่าวสารสามารถค้นหาและดาวน์โหลดข้อมูลที่ต้องการผ่านอุปกรณ์สื่อสารได้ทันท ี 

2. ประโยชน์ของการประชาสัมพันธ์ผ่าน Social Media 
2.1. เป็นการเพิ่มช่องการการประชาสัมพันธ์เว็บไซต์ และข้อมลูอ่ืนๆ 
2.2. เข้าถึงกลุ่มเป้าหมายได้โดยตรง เพราะเราสามารถส่งข้อมลูหรือข่าวประชาสัมพันธ์ต่างๆ ได้ถึง

บุคคลโดยตรง และสามารถเลอืกได้ว่าจะส่งให้ใคร 
2.3. ได้จํานวนสถิติผู้เข้าชมเว็บไซต์หลักของเรามากขึ้น เพราะเว็บประเภท social Network เช่น 

facebook ใหเ้ราสามารถใสล่ิงค์เว็บไซต์หน่วยงานของเราได้ เมื่อมีผู้เข้ามาดู FanPage ที่
สนใจและอยากจะรู้เกี่ยวกับข้อมูลข่าวสาร หรือกิจกรรมของเรามากขึ้น ก็สามารถคลิกไปยัง
เว็บไซต์หลักของเราได้ทันที ทั้งนี้ควรใส่ Facebook Widget ที่จะช่วยให้คนที่เข้ามายงั
เว็บไซต์หลักของเรา สามารถคลิกเข้าเยี่ยมและไปยังหน้า Fanpage เช่นกัน 

2.4. เป็นการสร้างความสัมพันธ์และทัศนคติที่ดีต่อผู้เข้าชมเว็บไซต์ได้มากขึ้น โดยการมีปฏิสัมพันธ์
โต้ตอบพูดคุย แลกเปลี่ยนทศันคติ 
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แหล่งอ้างอิง 
 
http://incquity.com/articles/tech/10-ways-facebook-fan-page-help-business 
http://www.adslthailand.com/forum/viewtopic.php?t=26507 
http://www.marketeer.co.th/inside_detail.php?inside_id=720 
http://www.sara-dd.com 
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ภาคผนวก



 

 
 

 
 
 

คู่มือการใช้งาน Plug-in ใน FaceBook 
 

 
 
 
 
 
 
 

จัดทําขี้นเพื่อสนับสนุนการประชาสัมพันธ์ข้อมูลข่าวสารผ่านสื่อใหม่  
(New Media) 

 
 
 
 
 

ศูนย์เทคโนโลยีสารสนเทศการประชาสัมพันธ์ กรมประชาสัมพันธ์ 
 
Facebook เป็นเว็บประเภท Soical Network เว็บไซต์หนึ่งที่มีผู้นิยมใช้งานกันมากที่สุดแห่งหนึ่ง

ของโลก เพียงแค่สมคัรเป็นสมาชิกกับ Facebook เราก็จะสามารถแบ่งปันข้อมูล รูปภาพ ความรู้สึก
ผ่านทางหน้าเว็บไซต์ของ Facebook ได้ และจุดประสงค์หลักของ Facebook คือ การหาเพื่อนเก่า
ผ่านทาง Facebook และสามารถหาเพื่อนใหม่ๆ  ได้จากทกุมุมโลกเช่นกนั 
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1. การสรา้งปุ่ม like (like Button) ในเว็บไซต์ของเรา 

เราสามารถสรา้ง Like Button ให้แสดงผลในหน้าเว็บไซต์ของเราได้    ซึ่งจะมีประโยชน์ใน
การช่วยประชาสัมพันธ์ข่าว หรือกิจกรรมทีเ่ผยแพร่บนเว็บไซต์ของเราได้    

 
ขั้นตอน   
1.1 เข้าไปที่ http://developers.facebook.com/docs/reference/plugins/like จะเข้าสู่

หน้าบริการ Social Plugin เพื่อสร้างโค้ด Like 
1.2 กําหนดค่าต่างๆ ลงในแบบฟอร์ม 

 

 
ภาพตัวอย่างการติดต้ังปุ่ม Like 
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- Url to like : เว็บไซต์ที่ต้องการ 
- Width : ความกว้าง ของปุ่ม 
- Font : รูปแบบตัวอักษร 
- Verb to display : ข้อความที่ต้องการให้
แสดงบนปุ่ม  
- Show faces : ต้องการให้แสดงรูปภาพที่
อยู่ใน profile หรือไม่ 
- Color Scheme : ลักษณะของโทนสีที่ใช้ 
มีให้เลือกมืดและสว่าง  

 

 
1.3  คลิกที่ปุ่ม Get Code 

 
ภาพตัวอย่าง Code  
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1.4 Copy Code ที่อยู่ในช่อง iframe มาทั้งหมด 
1.5 แทรก Code ที่ได้มา ไปยังเว็บไซต์ของเรา ณ ตําแหน่งที่เราต้องการให้แสดง   

  
2. การสรา้งแสดงความเห็น (Facebook Comment) ในเว็บไซต์ของเรา 

 

 
ภาพตัวอย่างการแทรก Facebook Comment 

ขั้นตอน   
2.1  เข้าไปที่ 

http://developers.facebook.com/docs/reference/plugins/comments/ 
2.2  กําหนดค่าต่างๆ ตามความต้องการ 
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- URL to comment on : URL ของ 
WEBSITE  

- Number of posts : จํานวนข้อความที่
ต้องการให้แสดง 

- Width : กําหนดความกว้าง(หน่วยเป็น 
Pixel) 

- Color Scheme : ลักษณะของโทนสีที่ใช้ มี
ให้เลือกมืดและสว่าง 

 
 
2.3 คลิกปุ่ม Get Code 

 

 
ตัวอย่าง Code ที่ได้มา 

 
2.4 Copy Code ที่ได้มา และนาํไปติดยังหน้าเว็บไซต์ หรือเว็บเพจของเรา ณ ตําแหน่งที่เรา

ต้องการ 
 
 
 
 
 
 
3. การสรา้ง FanPage ใน Facebook  
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Fan Page คือ เว็บเพจที่สร้างขึ้นมาเพื่อที่จะประชาสัมพันธ์สิ่งต่างๆ เช่น ข่าวสาร กิจกรรม 
ตลอดจนสินค้าและบริการต่างๆ ให้กับเพื่อนๆ หรือบุคคลอื่นๆ ที่สนใจในสิ่งที่ประชาสัมพันธ์ ดังนั้น
ประโยชน์จาก Fan Page จึงมีหลายๆ ด้าน เช่น การประชาสัมพันธ์ข่าวสารของหน่วยงาน การโฆษณา
สินค้า การเผยแพร่ข้อมูลจากเว็บไซต์หลัก และบริการต่างๆ และยังสามารถเข้าถึงกลุ่มบุคคลต่างๆ ได้
อย่างกว้างขวางและแบบเฉพาะเจาะจง นอกจากนั้นยังประหยัดเวลาและค่าใช้จ่ายในการโฆษณาและ
เป็นอีกช่องทางที่เข้าถึงกลุ่มเป้าหมายที่อยู่บนโลกออนไลน์ 

ขั้นตอน 
 3.1 ในกรณทีีม่ี Account ของ Facebook แล้ว หากเรา Login Facebook ไว้อยู่แล้ว ให้เข้าไป

ที่ http://www.facebook.com/pages/create พอคลิกเข้าไปแล้วจะปรากฏหน้านี้ 
 

 
 

ดูบริเวณตรงกลางหน้าเว็บเพจ ให้เลือกไปทีป่ระเภทของเนื้อหาที่เราต้องการประชาสัมพันธ์ 
เช่น ธุรกิจ บันเทิง หรืออื่นๆ  ในที่นี้เลือกที่ Company, Organization or Institution 
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เมื่อระบบแสดงข้อมูลดังภาพขึ้นมา ทําการเลือกประเภทและชื่อหน่วยงานว่าเราจะสร้างเว็บเพ
จของอะไร เช่น 

 เลือกหมวดหมู่ : หน่วยงานราชการ 
 ชื่อบริษัท : กรมประชาสัมพันธ์ 

 จากนั้นคลิก เริม่กันเลย 
 
3.2. ขั้นตอน การ Create page 

 

 
 

  Profile Photo จะปรากฎขั้นตอนแรกเป็นการ อัพโหลด ไฟล์รูปภาพโดยมีขนาดไม่
เกิน 4 mb อัพโหลดรูปภาพ มีอยู่ 2 วิธี   

   1. อัพโหลดรูปภาพ เลือกไฟล์ภาพจากเครื่องของเราเอง 
   2. Import a photo เลือกไฟล์ภาพจากเว็ปไซต์ โดยทําการใส่ url ไฟล์รูปภาพลงไป 
   จากนั้นคลิก ดําเนินการตอ่   * หากยังไม่ต้องการอัพโหลดรูปภาพ คลิก ขา้ม 

 
3.3 Get Fans เป็นขั้นตอนที่เชิญชวนบุคคลอ่ืนให้รู้จัก fanpage ของเรา 
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 เชิญชวนเพื่อน เชิญชวนเพื่อนใน facebook  
 Import Contacts อัพโหลดไฟล์รายชื่อผู้ติดต่อผ่านช่องทางอื่น เช่น ไฟล์ Outlook  
 หรือ Email 
 เมื่อทําการเสร็จสิ้นหรือไม่ทําการใดๆใหค้ลกิ ดําเนนิการต่อ  
 

 
 

3.4 Basic Info เป็นการให้รายละเอียดเบื้องต้น 
   เว็บไซต์ : บอก ช่ือเว็บไซต์ 
   นี่คือ : ลักษณะหรือสิ่งที่บ่งบอกถึง fanpage ของเรา   
 

 คลิก ดําเนินการต่อ  
 * หากถ้ายังไม่ต้องการให้รายละเอียด คลิก ข้าม 

 

 
 
ในกรณีที่ขั้นตอนผ่าน จะขึ้นมาหน้าตาแบบนี้ แสดงว่าเราได้ Create Page ขึ้นมาแล้ว เป็นในส่วนของ
การต้ังค่าต่างๆ ในส่วนที ่  เราสามารถที่จะอพัโหลดรูปเป็น Profile Picture ได้ตามปกติ 
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ส่วนอื่นๆ ตามภาพ เป็นการส่งข้อมูลไปหาคนอื่นๆ ว่าเรามีเพจนี้ การโปรโมทเพจบนเว็บไซต์ การ
อัพเดทสถานะผ่านทางโทรศัพท์ 
 
 
 



 

 
 

คู่มือการพฒันา 
 
 
 
 

Radio Online Application  
on Android Operation System 

 
  
  
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

ศูนย์เทคโนโลยีสารสนเทศการประชาสัมพันธ์ กรมประชาสัมพันธ์ 
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บทนํา 
  
1.1 ความเป็นมา 

ในปัจจุบันอุปกรณ์สื่อสาร (Mobile Media) ได้เข้ามามีบทบาทในชีวิตประจําวันมากขึ้น นอกจากจะใช้ใน
การสื่อสารในรปูแบบโทรศัพท์แล้ว ยังใช้เลน่อินเทอร์เน็ต การรับข่าวสารโฆษณา ดูหนัง และฟังเพลง 
เรียกได้ว่ากําลังจะกลายเป็น สื่อมวลชนยุคใหม่ อาจกล่าวได้ว่า Mobile media เป็นสื่อที่เคลื่อนติดตาม
กลุ่มเป้าหมายไปอย่างไม่จํากัดสถานที่ และเวลา ต่างจากส่ือเดิมๆ ที่เคยใช้เป็นเครื่องมือทางการตลาด 
และอาจจะถูกลดความสําคัญไปเรื่อยๆ 
ปัจจุบัน กรมประชาสัมพันธ์ได้ให้บริการวิทยุออนไลน์ผ่านเว็บไซต์ www.prd.go.th อยู่แล้ว เพื่อเป็นการ
ขยายฐานผู้รับฟังวิทยุกรมประชาสัมพันธ์ จึงควรมีการพัฒนาวิทยุออนไลน์ที่สามารถฟังได้ผ่าน
โทรศัพท์มือถือ ถือเป็นการสรา้งสื่อใหม่ (New Media) อีกช่องทางหนึ่งในการให้บริการ 
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วัตถุประสงค์ 
 

2.1 เหตุผลที่ศึกษา 

เนื่องจากในปัจจบุันนี้ อุปกรณ์สื่อสารไร้สายมีผู้ใช้เพิ่มมากขึ้น และยังมีข่าวสารอีกมากมายที่ปรากฏบนสื่อที่
เข้าถึงได้ง่ายเช่นเว็บไซต์ต่างๆ แต่หน้าเว็บเหล่านี้กลับ ไม่ค่อยปรากฏผู้ท่ีเข้าไปใช้บริการด้วยหลายๆเหตุผล เช่น 
“เว็บไซต์ใช้งานได้ยุ่งยาก” “ไม่มีความรู้ด้านอินเตอร์เน็ต” เป็นต้น ส่งผลให้บุคคลเหล่านี้บกพร่องในการได้รับรู้ข่าวสาร
ไปในอีกหนึ่งช่องทาง จึงน่าจะเปน็การดีกว่าถ้าบุคคลเหล่านี้สามารถใช้อุปกรณ์สื่อสารไร้สายเช่น โทรศัพท์มือถือ (Smart 
Phone) ในการติดต่อเว็บไซต์เหล่านี้ได้โดยตรงโดยหน้าตาของโปรแกรมถูกสื่อให้เข้าใจลักษณะการใช้ได้ง่าย และ ลด
ความซับซ้อนในการใช้งาน 

เหตุผลหลักในการเลือกพัฒนาเป็น แอนดรอยด์แอพพลิเคชั่นคือ ในตลาดของโทรศัพท์มือถือที่มี
ระบบปฏิบัติการแอนดรอยด์ มีการพัฒนาและเติบโตอย่างรวดเร็ว อีกท้ังยังมีการขยายตัวของจาํนวนผู้ใช้อย่างต่อเนื่องจึง
มีความเป็นไปได้อย่างมากที่จะพบผู้ใช้โทรศัพท์มือถือในระบบปฏิบัติการดังกล่าวมากกว่าระบบปฏิบัติการอื่นๆ 
 
2.2 วัตถุประสงค์ของการศึกษา 
 - เพื่อเพิ่มศักยภาพในการกระจายข่าวสารบนสื่อต่างๆมากขึ้น 
 - เพื่อให้ผู้บริโภคข่าวสารต่างๆได้รับข้อมูลและข่าวสารได้ว่องไวมากขึ้น 
 - เพื่อต่อยอดความรู้ท่ีมีและนําไปประยุกต์เพื่อใช้ได้จริงในอนาคต 
 
2.3 ผลที่คาดว่าจะได้รับ 

กรมประชาสัมพันธ์ สามารถกระจายข่าวสารเพิ่มได้อีกหนึ่งช่องทาง และยังสะดวกต่อบุคคลในองค์กรที่จะใช้ 
อุปกรณ์สื่อสารไร้สาย เพื่อบริโภคข่าวสารต่างๆได้ง่ายขึ้น 
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ขั้นตอนการพัฒนา 
 
3.1 อุปกรณ์ท่ีใช้ในการพัฒนา 
 Hardware 

1. คอมพิวเตอร์ ASUS A42J 
a. CPU Intel Core is-460M (2.4 GHz, L3 3 MB) 
b. RAM 2 GB DDR3 
c. Hard Disk 320 G 5400 RPM 
d. Wireless Lan IEEE 802.11 B/G/N 

2. โทรศัพท์มือถือ Nexus One Android 2.3 
 
Software 
1. Eclipse 
2. Android SDK 
3. Android Development Tool (ADT) plugin 

 
3.2 ข้อจํากัดในการพัฒนา 
 สําหรับ Application 
  Android version 2.3 ขึ้นไป 
 สําหรับตัวเครื่องที่ใช้พัฒนา 
  เครื่องคอมพิวเตอร์ท่ีใช้พัฒนาโดยเครื่องจะต้องเป็นตามนี้ 
  Windows XP (32  bit), Vista (32 หรือ 64 bit), หรือ Windows 7 (32 หรือ 64 bit ) 
  Mac OS X 10.5.8 หรือ สูงกว่า (X86 เท่านั้น) 
  Linux (ทดสอบบน Linux Ubuntu Hardy Heron) 
3.3 ชั้นตอนการปฏิบัติงาน 
 1. ติดต้ัง JAVA Runtime Engine (JRE) และ JDK 
 2. ติดต้ัง Enclipse 
 3. ติดต้ัง Android SDK 
 4. ติดต้ัง Android Development Tool (ADT) plugin สําหรับ Eclipse ติดต้ัง Android Platform และ 
Component อื่นๆ ท่ีจําเป็น 
 5. เริ่มการเชียนและแก้ไขโปรแกรมสืบค้น URL จัดหมวดหมู่ของแต่ละภูมิภาคตามลําดับ 
 6. ทําการแก้ไขหน้าตาของตัวโปรแกรมเพื่อให้ง่ายต่อการใช้งาน 
 7. จัดทําเอกสารและคู่มือการใช้งาน 
 
 
 
3.4 ขั้นตอนการติดต้ังตัวโปรแกรมเพื่อใช้ในการพัฒนา พร้อมภาพประกอบ 
 1. ติดต้ัง Eclipse 
  ตัว IDE ท่ีใช้ในการพัฒนาจะเป็น Eclpise  สามารถดาวน์โหลดได้ท่ี 
http://www.eclipse.org/downloads/ แนะนําให้ดาวน์โหลด Eclipse Classic หลังจากดาวน์โหลดมาแล้วให้แตก
ไฟล์ออกมาเท่านั้น เพราะ Eclipse ไม่จําเป็นต้องติดต้ัง 
 
 2. ติดต้ัง Android SDK 
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  ให้ดาวน์โหลดตัว SDK จาก http://developer.android.com/sdk/index.html โดยเลือกให้ตรง
กับ Platform ท่ีเราใช้พัฒนา หลังจาดดาวน์โหลดมาแล้วให้แตกไฟล์ออกมาจะได้เป็นชื่อ android-sdk-<machine-
platform> ในที่นี้ของเราใช้ windows ชื่อโฟลเดอร์ท่ีได้ก็จะเป็น android-sdk-windows จากนั้นเราควรทําให้คําสั่ง
ต่างๆ ของ SDK สามารถใช้งานได้ทุกท่ี โดยคลิกขวาที่ My Computer แล้วเลือก Properties จากนั้นเลือก Advanced 
Tab ด้านล่างสุด จะมีปุ่ม Environment Variables อยู่ให้คลิกแล้วจะมีหน้าต่างเล็กๆ ขึ้นมาท่ี System Variables ให้
หาคําว่า Path แล้วกด Edit จากนั้นให้ใส่ท่ีอยู่เต็มๆ ของ android-sdk-windows/tools ต่อด้านหลังสุด เช่น 
C:\android-sdk-windows\tools ถ้าหลังสุดไม่มี ; (semi-colon) อยู่ให้เติมไปด้วย เช่น ;C:\andriod-sdk-
windows\tools 
 
 3. ติดต้ัง ADT Plugin ผ่าน Eclipse 
  เปิด Eclipse ขึ้นมา (ท่ีดาวน์โหลดจากขั้นตอนแรก) ท่ีเมนูเลือก help -> Install New Software 
จะมีหน้าต่างใหม่ขึ้นมากดปุ่ม Add จะมีช่องให้กรอกข้อมูล 
  Name : ใส่ Android plugin 
  Location : ใส่ http://dl-ssl.google.com/android/eclipse/ 
  จากนั้นกด OK แล้ว หน้าต่าง Available SoftWare ในพี้นที่ว่างๆ ตรงกลางจะมี Developer 
Tools ปรากฏขึ้นมา ให้กดลูกศรหน้า Developer Tools จะมีปรากฏขึ้นอีก 2 หน้าต่าง คือ Android DDMS กับ 
Android Development tools ให้เลือกทั้งหมดแล้วกด Next ระบบจะทําการ Calculation จากนัน้ รอจนกว่าจะมีปุ่ม
ให้กด Next อีกครั้ง พอกดแล้วหน้าต่างจะแบ่งออกเป็น 2 ฝั่ง ฝั่งซ้ายจะเป็นรายชอง Software ท่ีเราจะติดต้ัง และ
ด้านขวาเป็น Agreement ให้เราเลอืก Accept แล้วกด Finish เมื่อทําการ Download และ Install เสร็จแล้ว ให้ 
Restart Eclipse ใหม่ 
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4. ติดต้ัง Platform Version ของ Android 
  ท่ีเมนู Window -> Android SDK and AVD Manager ด้านซ้ายเลือกแถบ Available packages 
ด้านขวาจะ repository ของ packages ให้เลือกที่ https://dl-
ssl/google.com/android/repository/repository.xml จะมี Platform ของ Android ขึ้นมา ให้เลือก version ท่ี
ต้องการจะพัฒนา (แนะนําให้เลือกหมด) จากนั้นกด Install Selected เพื่อยืนยันการติดต้ังให้กด Accept (กรณีเลือก
หลายอันกด Accept All) ขั้นตอนนี้จะค่อนข้างใช้เวลานาน เพราะต้องดาวน์โหลด Platforms ต่างๆ มาติดต้ังที่เครื่อง 
  ส่วน Platform ต่างๆ ท่ีติดต้ังจะอยู่ท่ี android-sdk-windows/platforms ท่ีเมนู window -> 
Preferences ด้านซ้ายเลือกแถบ Android ด้านขวาตรง SDK Location ให้เลือก directory ของ android-sdk-
windows ท่ีดาวน์โหลดมาในชั้นตอนที่สอง แล้วตารางด้านล่างจะแสดง Platform version ของ Android ท่ีได้ติดต้ังไว้ 
จากนั้นกด Apply 
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5. สร้าง Android Virtual Device (AVD) 
  Android Virtual Device เป็นตัวจําลอง Android บนเครื่องคอมพิวเตอร์หรือจะเรียกกันง่ายๆ ว่า 
Emulator ถ้าไม่มีเครื่อง Android ก็สามารถใช้ Emulator เพื่อแสดงผล Application ได้เลย ท่ีเมนู Window -> 
Android SDK and AVD manager ด้านซ้ายเลือกแถบ Virtual Devices ด้านขวากดปุ่ม New 
  Name : ต้ังชื่อ Device เช่น G1 หรือ Hero 
  Target : Platform version ท่ีต้องการ 
  SD Card : ขนาดความจําของ SD Card 
  Hardware : ส่วนนี้จะเป็นความสามารถของตัวเครื่องจําลองที่เราต้องการให้มี เช่น Camera 
Support, SD Card Support, Touch-screen support 
  
  เมื่อป้อนข้อมูลเรียบร้อยแล้ว ให้กด Create AVD จากนั้นให้เลือก Device ท่ีสร้าง แล้วกด Start -> 
launch 
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3.5 ขั้นตอนการใช้งานแอพพลิเคชั่น พร้อมภาพประกอบ 
 
1. เปิด Eclipse จากนั้นเลือก Workspace สําหรับการพัฒนา 
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2. ทําการ Import ตัวแอพพลิเคชั่น 

2.1. เลือก File -> Import -> Existing Project into Workspace -> next 
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2.2. เลือก Directory ของ PrdOnlineApp ท่ีได้แตกไฟล์ไว้ จากนั้นกด Finish 

 
 
3. เลือกเปิด Class StreamListActivity.java ขึ้นมาจากนั้นกด Run -> Run as Android Application เพื่อแสดงผล 
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4. เมื่อทําการกด Run -> Run as Android Application จะปรากฏหน้าจอดังต่อไปนี้ 
 

 
 
5. เริ่มใช้งานโดยทําการเลือกภาคจากนั้นเลือกเชตที่ต้องการ 
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6. เมื่อเสร็จสิ้นการเลือกจะเช้าสู่หน้าจอการรับฟังโดยแบ่งออกเป็นสองกรณี 

6.1. กรณีท่ี Url ของพื้นที่ท่ีเลือกอยู่ในสถานะ Offine 
 

 
 

6.2. กรณีท่ี Url ของพื้นที่ท่ีเลือกอยู่ในสถานะ Online 
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 หมายเหตุ ในกรณีท่ีการ Import เกิดปัญหาขึ้นคือ Import แล้ว Project ท่ีเราทําการ import มานั้นปรากฏ
เครื่องหมายกากบาทสีแดงขึ้น มีวิธีการแก้ไขดังนี้ 

1. คลิกขวาท่ี PrdOnlineApp -> Properties -> Java Build path จากนั้นเลือก jdom.jar และ 
jsoup.jar เพื่อทําการ Remove 

 

 
2. เลือก Add External JARs แล้วไปหาท่ี Directory ท่ี PrdOnlineApp อยู่ จากนั้นเลือกโฟลเดอร์ lib 

เลือก jdom.jar และ jsoup.jar แล้วกด Open-> OK 
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3.6 การ Export แอพพลิเคชั่นเพื่อการนําไปติดต้ัง 
 1. เลือก File -> Export -> Android -> Export Android Application 

 
 

 2. ทําการเลือกไฟล์ท่ีต้องการ Export จากนั้นใส่ Keystore และ Password ตามต้องการ แล้วกด Next 
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 3. ใส่ค่า Alias ตามต้องการ และระบุอายุการใช้งาน จากนั้นเลือก Directory ท่ีต้องการแล้วกด Finish 
 

 
 

 
 
3.7 การตั้งค่าในโทรศัพท์มือถือ 

1. ดาวน์โหลด ไฟล์ติดต้ัง PrdonlineApp.apk  
- เข้าไปท่ี ระบบอินทราเน็ต (http://intranet.prd.go.th) –> สื่อเผยแพร่ ศสช. –> ดาวน์โหลด –> 
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- เลือก ดาวน์โหลด PrdonlineApp.apk เพื่อบันทึกเก็บไว้ใน memory card ของโทรศัพท์มือถือแอน
ดรอยด์  

 

 
 

2. การตั้งค่าของมือถือแอนดรอยด์ เพื่อให้สามารถติดต้ังโปรแกรมที่ไม่ได้ดาวน์โหลดจากแอนดรอยด์มาร์เก็ต 
- เข้าไปท่ี Setting –> application 
- เลือก Unknown Source 
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3. ไปท่ี File Explorer เลือก SD Card 
4. แตกไฟล์ จากนั้นเครื่องจะทําการ Install ให้โดยอัตโนมัติ 
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แหล่งอ้างอิง 
 http://androidthai.in.th/developer/51-holloword-android.html 
 http://bogotobogo.com/android.html 
 http://meewebfree.com/site/android/300-build-android-application-form-scratch 
 

 


